
Experiment HM-4: Stimulus Response, Work, Summation, and Tetanus in Human 

Muscle

Equipment Required

PC or Mac Computer

IXTA, USB cable, Power supply for IXTA 

HV stimulator lead wires for IXTA 

Disposable electrodes

SMT-220 Striated muscle transducer

Surgical tape or Velcrotm straps

Thread

Weights (10, 20, 30, 40, 50 grams)

IXTA Stimulator Setup

1. Place the IXTA on the bench near the subject. 

Warning: Before connecting the IXTA stimulating electrodes to the subject, check the Stimulator 

Control Panel to make sure the amplitude value is set to zero (0).

Note: Disconnect the subject from the IXTA prior to powering off the device.

Figure HM-4-S1: The IXTA stimulating electrodes.
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Figure HM-4-S2: The front panel of the IXTA with the stimulating electrodes connected correctly. The 

Twitch sensor is plugged into channel A7.

2. Instruct the subject to remove all jewelry before beginning the experiment. 

3. Connect the color-coded stimulator lead wires to the High Voltage Current Stimulator. Make 

sure you push the safety connector of each lead wire into the appropriate socket as far as 

possible.

4. Plug the SMT-220 into channel A7 on the front of the TA.

Positioning of the Stimulating Electrodes

Before attaching the SMT-220 striated muscle transducer to the side of the subject’s hand, determine 

the positions for the stimulating electrode that cause the muscles of the little finger to create a strong 

twitch response.

1. Obtain a couple of disposable electrodes. Attach one electrode to the center of the back of the 

hand. The electrode should be half way between the first knuckle of the middle finger and the 

wrist. This electrode is the positive (red) stimulating electrode.

2. Attach the second electrode about one centimeter above the lateral edge of the hand, half way 

between the first knuckle of the little finger and the wrist. This electrode is the negative (black) 

stimulating electrode. 

3. Snap the ends of the H.V. Output lead wires onto the stimulating electrodes, so that:

• the red (+) lead is snapped on the electrode in the center of the back of the hand,

• the black (-) lead is snapped on the electrode at the lateral edge of the hand.
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Figure HM-4-S3: A. Placement of the stimulating electrodes on the back of the left hand. B. Placement 

of the sensor on the outer edge of little finger.

4. The SMT-220 generates a signal only when flexed in one direction. Locate the label on the 

sensor that indicates the side of the sensor that will need to face outwardly from the finger.

5. Align the SMT-220 along the side of the little finger so the outside of the sensor is oriented 

away from the finger. Use a Velcrotm strap, or piece of surgical tape, to attach the tip of the 

sensor to the end of the little finger. Use a longer Velcrotm strap, or piece of surgical tape, to 

attach the base of the sensor along the lateral edge of the palm of the hand.

Figure HM-4-S4: The SMT-220 muscle transducer with a label indicating the side of the sensor that 

faces to the outside.
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6. Check the values for the stimulus parameters that are listed in the stimulator control panel on 

the Main window: the pulse amplitude (Amp) should be set to 5.0V or mA, the pulse width (W)

to 5 ms, the frequency (F) to 1 Hz; and, the number of pulses (#pulses) to 15. The value for a 

stimulus parameter can be changed by typing the value in the window next to the label of the 

parameter. Click the Apply button to finalize the changes.

7. Click on the Stimulator button in the LabScribe toolbar to open the Stimulator control panel on 

the LabScribe Main window. Compare the values set for the IXTA stimulator to the values 

programmed on the Preferences Dialog window, which can be viewed by selecting Preferences 

from the Edit menu on the LabScribe Main window. Make any changes to the parameters that 

are necessary and click on the Apply button to complete the changes.  The Apply button will 

change to Fire when recording.

Warning: Make sure the Amplitude on the Stimulator Control Panel is set to zero. 

8. Click Record and then click Fire on the stimulator control panel. There should be no response 

from the subject’s finger since the current output is zero. Continue to record.

9. Enter the amplitude value into the Stimulator Control Panel and click APPLY which then 

changes to FIRE – click FIRE to send out the stimulation.  For each “1” amplitude increase it is 

equal to a current output of 2 milliamperes (mA). Remind the subject to indicate the first 

occurrence of tingling. If no finger movement is seen, the stimulus current is below the 

threshold current of the most sensitive muscle fibers controlling the finger’s movement. 

Threshold is the current level that is needed to create a muscle fiber contraction.

Note: The amplitude required to cause a finger twitch will differ between subjects. Some subjects 

require as low as 2.5 milliamperes of current (1.25 amplitude) to create a maximum response, while 

other subjects may require 7 or more milliamperes (3.5 or more amplitude) to create the strongest 

response.

10. If a finger twitch does not occur at 2 mA, change the Amplitude by an additional 0.5. Click the 

Apply button.  Check for tingling and finger movement. Increase the current output in 

increments of 0.5 until the subject’s finger twitches with the largest range of motion.
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 Note: As the current output is increased in the next couple of steps, ask the

 subject to indicate when they first feel any tingling under the negative 

stimulating

 electrode. Minor movement of the subject’s finger can usually be seen when the

 stimulus current is raised another milliamp or two.

 NOTE – the pinkie may not twitch and another finger will twitch. 

 If this happens, just move the twitch sensor to the finger that is actively twitching.  

 It can be any finger and does not need to be the pinkie.



11. If the stimulus current has been raised to 10 in the Amplitude box and the subject feels tingling 

but no finger movement is observed, click Stop and adjust the position of the negative 

stimulating electrode before making additional increases in the stimulus current. 

• Make sure to stop the recording before moving the electrodes.

• Move the negative stimulating electrode a centimeter closer to the positive stimulating 

electrode. 

• Stimulate the subject’s hand. Raise the stimulus current as high as 5 mA. If the response 

from the subject’s hand is miniscule, or non-existent, place the negative electrode at 

different points along an imaginary line on the back of the hand, from the base of the 

little finger to the lateral edge of the wrist. 

12. Find the lowest stimulus current that creates the largest twitch from the subject’s finger, click 

Stop to turn off the stimulator. 

13. Set the current at this level for Exercise 1. 

Note: The lowest stimulus that causes the largest possible response is called the maximal stimulus. 

Any stimulus that is above the maximal level is known as supra-maximal. Currents above threshold 

and below maximal are called sub-maximal.

IXTA Isolated Stimulator

The IXTA has a high voltage stimulus isolator designed to deliver constant current to the nerve or 

muscle being studied. In situations where the resistance (R) along the path of the current increases, the 

voltage (V) increases to maintain the current (I in V = IR, Ohm’s Law). The ability of the IXTA to 

adjust the voltage to deliver the required current is known as voltage compliance. The upper limit of 

this compliance by the IXTA is set at 100 Volts.

Constant current devices differ from constant voltage devices when presented with an increase in 

resistance, like the dehydration of the conductive gel under the electrodes. As pointed out earlier, a 

constant current stimulator is voltage compliant. In constant voltage stimulators, the current delivered 

to the tissue decreases as the resistance increases because the power supply of the constant voltage 

device is not designed to deliver additional current. 

Although the IXTA can generate up to 100 Volts, the current delivered by the unit is limited to a 

maximum of 20 milliamperes, for a maximum duration of 10 milliseconds per pulse, and a maximum 

frequency of 50 pulses per second (Hz). At these levels, the maximum amount of power delivered by 

the IXTA will not cause injury or tissue damage.

The current is selected using the Stimulator Control Panel. The HV Stimulator can deliver a maximum 

output of twenty milliamperes

The duration, frequency, and number of stimulus pulses generated by the stimulator are also controlled

by making changes to the values in the Stimulator Control Panel. The initial values of the pulses 

generated by the IXTA are programmed by the same settings file that configured the recording 

software. For example, if a pulse from the IXTA is programmed for a duration of 1 millisecond and a 

frequency of 1 Hz, the stimulator will generate a stimulus pulse with the same duration and frequency. 
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Experiment HM-4: Stimulus Response, Work, Summation, and Tetanus in Human 

Muscle 

WARNING - The Stimulator should only be used for the method of application for which the 

Stimulator is intended as shown in the directions below.

Note: Disconnect the subject from the IXTA prior to powering off the device.

If the subject feels a painful stimuli, then the electrodes are in the wrong place.

 

Exercise 1: Properties of a Finger Twitch

Aim: To become familiar with using a high voltage stimulator and to record a finger twitch with and 

without a weight attached to the finger.

Approximate Time: 15 minutes

Procedure

1. Instruct the subject to relax and place the hand that is used for the experiment on the bench, 

with its palm up.

2. Click the Stimulator Preferences icon on the LabScribe toolbar to open the stimulator control 

panel if it does not open automatically.

Figure HM-4-L1: The LabScribe toolbar.

Figure HM-4-L2: The stimulator control panel.  
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 NOTE: If using the IXTA and built in HV stimulator – all changes in Amplitude

 are entered directly into the Stimulator Control Panel.  Click “APPLY” to make

 any changes. “APPLY” will change to the word “FIRE”. When recording, click

 “FIRE” to fire the actual stimulus. 



3. Check the values for the stimulus parameters that are listed in the stimulator control panel on 

the Main window: the pulse amplitude (Amp) should be set to 5.0V or mA, the pulse width (W)

to 5 ms, the frequency (F) to 1 Hz; and, the number of pulses (#pulses) to 15. The value for a 

stimulus parameter can be changed by typing the value in the window next to the label of the 

parameter. Click the Apply button to finalize the changes.

4. When using the IXTA change the amplitude in the software to set the stimulus current to the 

level determined in the Setup section of this lab.

5. Type the < Subject’s Name> in the Mark box. Click Record. Click the mark button to mark the 

recording. Continue to record for 15 to 20 seconds. Click the Stop button. 

6. Select Save As in the File menu, type a name for the file. Click on the Save button to save the 

data file.

7. Leave all the stimulus parameters at the same settings.

Data Analysis

1. Scroll through the recording of the finger twitches. Notice each finger twitch has two phases, a 

quick contraction phase followed by a slow relaxation phase. Since the duration of the stimulus 

pulses are short and their frequency is low, the muscles of the finger have the opportunity to 

fully relax between twitches as indicated by the return of the twitch amplitude to the same 

baseline between twitches.

2. Use the Display Time icons to adjust the Display Time of the Main window to show at least 

three complete twitches on the Main window. 

3. Data can be collected from the Main window or the Analysis window.  If you choose to use the 

Analysis window, click on the Analysis window icon in the toolbar.

4. The mathematical functions, V2-V1 and T2-T1 should appear on screen. Values for V2-V1 and 

T2-T1 on each channel are seen in the table across the top margin of each channel, or to the 

right of each graph.

5. The functions in the channel pull-down menus of the Analysis window can also be used to enter

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the amplitude and times of each finger

twitch.

• Transfer the names of the mathematical functions used to determine the amplitude and 

times to the Journal using the Add Title to Journal function in the Finger Twitch Channel

pull-down menu.

Human Muscle – HumanMuscleTwitch – Labs HM-4-2

 

 Remember to click APPLY to change the stimulus parameters and FIRE to generate the pulses.



6. Once the cursors are placed in the correct positions for determining the amplitude and times of 

each finger twitch, the values of the parameters can be recorded in the on-line notebook of 

LabScribe by typing their names and values directly into the Journal, or on a separate data table.

7. Transfer the values for the amplitude and period to the Journal using the Add Ch. Data to 

Journal function in the Finger Twitch Channel pull-down menu.

Figure HM-4-L3: Finger twitches recorded without a weight attached to the finger, seen on the upper 

channel. The signal of the high voltage stimulus isolator is seen on the lower channel at a frequency of 

1Hz. 

8. On the Finger Twitch channel, use the mouse to click on and drag the cursors to specific points 

on the recording to measure the following parameters: 

• Twitch Amplitude. To measure the amplitude of the twitch, place one cursor on the 

baseline at the point just before the twitch starts to develop, and the second cursor on the

peak of the twitch. On the Finger Twitch channel, the value for V2-V1 is the amplitude 

of that twitch.

• Contraction Time, which is the time it takes the amplitude of the twitch to rise to its 

peak. To measure the contraction time of the twitch, keep the cursors in the same 

positions used to measure the twitch amplitude. On the Finger Twitch channel, the value 

for T2-T1 is the contraction time of that twitch.
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 Any movement, voluntary or involuntary, will be recorded. It is important 

 that the hand is fully relaxed and in a comfortable position. 



• Relaxation Time, which is the time it takes the amplitude of the twitch to return to 

baseline. To measure the relaxation time of the twitch, place one cursor on the peak of 

the twitch, and the second cursor at the point where the amplitude returns to the baseline.

On the Finger Twitch channel, the value for T2-T1 is the relaxation time of that twitch.

Figure HM-4-L4: Finger twitches stimulated by maximal current at a frequency of 1 Hz.

Question

How does the contraction time of a typical finger twitch compare to the relaxation time?

Exercise 2: The Effect of Weight on Finger Twitches

Aim: To determine the amount of work performed by the finger with different weights, or loads, 

attached to the finger.

Approximate Time: 30 minutes

Procedure

1. Check the stimulus parameters set in the Stimulator control panel on the LabScribe Main 

window. These settings should be the same as the ones used in Exercise 1.

2. Set the stimulus current to the maximal level as used in Exercise 1.  
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3. Attach a thread to the last joint of the finger being used in the experiment. The thread should be 

long enough to go across the ring, middle, and index fingers of the same hand, and also allow 

the weight to hang over the edge of the table. Attach a weight to the other end of the thread. The

weight could be a pen, a pencil, or washers.

4. Have the subject move their hand to the edge of the table, so the palm is up and the thread with 

the weight is hanging along the side of the table.

5. Type the weight of the object, that is on the thread, in the Mark box. Click Record. Click the 

mark button to mark the recording. Continue to record for 15 seconds. Click the Stop button.

6. Add another 10 gram weight to end of the thread and repeat Step 5.

7. Continue to add weight to the thread in 10 gram increments. Repeat Step 5 each time you add 

weight to the thread until the amplitude of the finger twitch is undetectable.

8. Select Save in the File menu on the LabScribe window. 

9. Remove the weights and thread from the subject’s finger.

Data Analysis

1. Scroll to the beginning of the recording for this exercise. Locate the section of data in which 

finger twitches appeared when the stimulus threshold was reached. Click AutoScale to 

maximize the size of the twitch on the window. 

2. Use the Display Time icons to adjust the Display Time of the Main window to show a segment 

with four or five twitches on the Main window. 

3. Use the same techniques used in Exercise 1 to measure and record the amplitudes (V2-V1) of 

three twitches recorded at each weight.

4. For each weight, determine the average amplitude of three finger twitches. 

5. Use the average twitch amplitude at each weight to calculate the work performed on that 

weight. For this exercise, use the following equation:

Work = Weight (g) x Average Amplitude of Twitch (mv) with that Weight

6. In Excel plot the work performed at each weight as a function of the weight attached to the 

finger.

Questions

1. How do the amplitudes of the finger twitches with different weights compare to each other?

2. Why did the amount of work decrease when heavier weights were used?

3. Is there any correlation between the weight moved and the contraction or relaxation times of the

twitches?
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Figure HM-4-L5: The relationship between work performed at each weight and the weight moved by a 

finger twitch

Exercise 3: Stimulus-Response

Aim: To examine the effect of stimulus current on the amplitude of finger movement.

Approximate Time: 30 minutes

Procedure

1. Remind the subject to relax and place the hand that is used for the experiment on the bench, 

with its palm up.

2. Check the stimulus parameters set in the stimulator control panel. The duration of the stimulus 

pulses should be 5 milliseconds (ms), their frequency should be 1 Hz, and the number of pulses 

(#p) should be 0 (zero). Setting the number of pulses to zero makes the stimulator fire 

continuously. If the values of these parameters were changed, click the Apply button on the 

Stimulator control panel to effect the change

3. Make sure the Amplitude is set to 0.  Type Zero in the Mark box. Click Record and click the 

mark button to mark the recording. 

4. While recording, type 0.5 mA in the Mark box. Increase the current output by 0.5mA. Click 

APPLY and then FIRE. Click the mark button to mark the recording. Record at this stimulus 

current for ten to fifteen seconds.

5. Repeat Step 4, in increments of 0.5 mA, until the stimulus current reaches the maximal level. 

Click the Stop button. 

6. Open the File menu and select Save to save the data file.
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Data Analysis

1. Scroll to the beginning of the data for this exercise. Locate the segment of the finger twitches 

that occurred at threshold stimulus current. Click AutoScale to maximize the size of the twitch 

on the window. For any stimulus currents that did not cause finger movement, report the 

amplitude of the finger twitch as zero (0).

2. Use the Display Time icons to adjust the Display Time of the Main window to show a segment 

with four or five twitches on the Main window. 

3. Use the same techniques used in Exercise 1 to measure and record the amplitudes (V2-V1) of 

three twitches recorded for each stimulus current that causes a response.

4. For each stimulus current, determine the average amplitude of three finger twitches. 

5. In Excel plot the average amplitude of the finger twitch at each stimulus current as a function of

the stimulus current.

Figure HM-4-L6: Average finger twitch amplitude as a function of the stimulus current

Questions

1. At which stimulus current did the finger first show a twitch? Why didn’t a finger twitch occur at

a lower stimulus current? 

2. How does the finger twitch amplitude increase when the stimulus current is increased?

3. Is there a stimulus current at which the amplitude of the finger twitch is maximized?

4. Above a certain stimulus current, the amplitude of the finger twitch no longer increases. Why 

does this happen?
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Exercise 4: Summation and Tetanus

Aim: To monitor the contraction and relaxation of the finger twitch in relation to the stimulus 

frequency.

Approximate Time: 30 minutes

Procedure

1. Remind the subject to relax and place the hand that is used for the experiment on the bench, 

with the palm up.

2. Check the stimulus parameters set in the stimulator control panel. The duration of the stimulus 

pulses should be 5 milliseconds (ms), their frequency should be 1 Hz, and the number of pulses 

should be set to 40. 

3. During the course of this exercise, the stimulus frequency will be changed to demonstrate 

summation and tetanus. After any stimulus parameter is changed, click the Apply button on the 

Stimulator control panel to make the change.  Click Fire to fire the stimulation.

4. Set the stimulus current to the maximal level as used in Exercise 1.

5. Type 1 Hz in the Mark box. Click Record and click the mark button. Do not stop the recording 

There should be forty twitches on the recording.

6. Change the stimulus frequency to 2 Hz. Click the Apply button to put any frequency change 

into effect.

7. Repeat Step 5 with the stimulus frequency set to 2. Type 2 in the Mark box. When the subject is

ready – click Fire.

8. Repeat Step 7 for stimulus frequencies of 3, 4, 5, and then 10, 15, and 20 Hz. Remember to 

click the Apply to make the changes and Fire to send the stimulation.

9. When performing the experiment at the highest frequency (20 Hz) keep recording after 

complete tetanus is reached. Continue to record for at least 10 seconds as the tension in the 

muscles of the finger begins to relax.

10. When the muscles in the finger are fully relaxed, click Stop to halt the recording.

11. Select Save in the File menu.

Data Analysis

1. Scroll to the beginning of the data for this exercise. Locate the segment of the finger twitches 

that occurred at a frequency of 1 Hz. Click AutoScale to maximize the size of the twitches on 

the window. 

2. Use the down arrow to the right of the Mark button to locate the mark for 1 Hz, click that mark 

and the recording will bring you right to that section of data.

3. If needed, use the Display Time icons to adjust the Display Time of the Main window to show 

the twitches at that frequency on the Main window. 
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Figure HM-4-L7: Amplitudes of finger twitches at 10, 15, and 20 Hz from left to right. Recordings from

10 and 15 Hz show incomplete tetanus. Complete tetanus occurs at 20 Hz.

4. Use the same techniques used in Exercise 1 to measure and record the amplitudes (V2-V1) of 

two adjacent twitches recorded at a stimulus frequency of 1 Hz.

5. Move to the segment of data recorded at the next stimulus frequency by clicking the down 

arrow next to the mark button and clicking on the next mark. If the twitches at this frequency 

are all about the same amplitude, measure and record the amplitudes of two adjacent twitches.

6. Repeat Step 5, until the recording of the finger twitches show summation. Summation occurs 

when the time between twitches is not long enough to allow the muscle to completely relax to 

its baseline level of tension. Another twitch or contraction, following in quick succession to the 

first, will add on the first twitch at the current level of tension for the first twitch. The third 

twitch will add on to the current tension of the second twitch, and so on. Since the twitches 

were maximal, this summation is a form known as mechanical summation.

7. At stimulus frequencies where summation occurred, measure and record the amplitude of the 

first twitch in the series and the amplitude of the tallest twitch in the series.

8. If a level of relatively constant tension occurs during contractions at high frequency, the 

phenomenon is called tetanus. If small relaxations are still detectable along the level of constant

tension, a state of incomplete tetanus exists (5 Hz, 10 and 15 Hz). If there are no detectable 

relaxations along the region of constant tension, a state of complete tetanus exists (20 Hz).
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Figure HM-4-L8: Summation of finger twitches occurring at a stimulus frequency of 5Hz. 

Questions

1. At which frequency did summation first appear? At which frequencies does incomplete tetanus 

occur? At which frequency did complete tetanus first occur?

2. How much greater than the amplitude of a single twitch is the amplitude of the tallest twitch 

during summation or incomplete tetanus?

3. How much greater than the amplitude of a single twitch is the amplitude of complete tetanus?

4. After the stimulator is turned off, the relaxation time after tetanus is much longer than 

relaxation time after a single twitch. Why?

5. What is the name for the decrease in the level of constant tension that occurs during tetanus?
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